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Oracle Calendar
This document contains the following sections:

• Overview
• Get an Account or Resource
• Access Calendar
• Using the Desktop Client

(http://www.cmu.edu/computing/doc/software/calendar/desktop/index.html)
• Using the Web Client

(http://www.cmu.edu/computing/doc/software/calendar/web/index.html)
• Resource Accounts

(http://www.cmu.edu/computing/doc/software/calendar/resource/index.html)
• Export Data

(http://www.cmu.edu/computing/doc/software/calendar/export/index.html)
• Designates

(http://www.cmu.edu/computing/doc/software/calendar/designate/index.html)
• Quick Start (version 10.1.2)
• Usage Tips

For information related to this topic refer to:

• Guidelines for Use
o Students (http://www.cmu.edu/computing/guideline/calendar-students.html)

o Faculty and Staff (http://www.cmu.edu/computing/guideline/calendar.html)
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Overview of Andrew Calendar
The Andrew Calendar service is a campus-wide calendar management and
scheduling system. It allows you to create a personal calendar and to track
appointments and meetings. The real power of Andrew Calendar comes from its
ability to share meetings with others, which allows it to act as a group organizer.
Oracle Calendar is the client side application that allows you to access the Andrew
Calendar service. Computing Services also supports an Oracle Calendar Web Client
(https://calendar.andrew.cmu.edu/)  which can be accessed via the My Accounts tab of
the Carnegie Mellon Web Portal (https://my.cmu.edu/) .

Where to Get Help

These pages are intended to help you through the basic steps of installing and gaining
familiarity with the product. Additionally, the Oracle Calendar client and web applications
come with rather extensive on-line help files.

If you need immediate help with the installation or use of this application, contact
the Help Center at 8-4357 or email Advisor (mailto:advisor@andrew.cmu.edu) .
Training on Oracle Calendar and the Andrew Calendar service are available through
Computer Education. For additional information, please e-mail Computer Education
(mailto:computer-education@andrew.cmu.edu)  or visit Education and Outreach.
(http://www.cmu.edu/computing/ed-outreach/index.html)

Last Updated: 01/30/07

https://calendar.andrew.cmu.edu/
https://calendar.andrew.cmu.edu/
https://my.cmu.edu/
mailto:advisor@andrew.cmu.edu
mailto:computer-education@andrew.cmu.edu
mailto:computer-education@andrew.cmu.edu
http://www.cmu.edu/computing/ed-outreach/index.html
http://www.cmu.edu/computing/ed-outreach/index.html


calendar-pdf

- 3 -

Get an Andrew Calendar Account and/or Resource

Andrew Calendar Accounts

In order to use Oracle Calendar, you must have an Andrew Calendar account.
Because Oracle Calendar works best when everyone in a group or department has
an account, many departments have chosen to get "on board" with the program as a
group. Individuals or department administrators can request accounts by completing
the appropriate form on the My Accounts tab of the Carnegie Mellon Web Portal
(https://my.cmu.edu/) .

Resources

If your department or group needs to schedule rooms, equipment or
other resources, an account needs to be created for that resource.
To request an account for a resource, complete the Requesting a
Resource (http://www.cmu.edu/computing/email/calendar/resource.html) 
form. Please see Resource Accounts
(http://www.cmu.edu/computing/doc/software/calendar/resource/index.html)  for more
help with resources.
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Access the Calendar
You can access Oracle Calendar by downloading the desktop client software and/or via
the web client.

Desktop Client

Computing Services supports Oracle Calendar for Mac, Windows and Unix
machines. Installation instructions are available as part of the installation
package on the My Accounts tab of the Carnegie Mellon Web Portal
(https://my.cmu.edu/) . Please see Using the Oracle Calendar Desktop Client
(http://www.cmu.edu/computing/doc/software/calendar/desktop/index.html)  for more
details.

Web Client

Oracle Calendar also allows users to access their calendar information
through the Internet. It is not necessary to have the Oracle Calendar software
installed to view and modify a calendar via the web client. Although there
are some limitations to the web interface, it does provide a quick way to
access information. Please see Using the Oracle Calendar Web Client
(http://www.cmu.edu/computing/doc/software/calendar/web/index.html)  for details.

Andrew UNIX Environment

Andrew Calendar has been installed to the Andrew UNIX environment. To launch
Andrew Calendar, type oraclecalendar at the system prompt.

Last Updated: 01/30/07
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Oracle Calendar Client 10.1.2 Enhancements At a
Glance
This document is intended to serve as a "Quick Start" guide to using the new features
of the Oracle Calendar Client version 10.1.2. It does not replace the Oracle Calendar
document.

For information related to this topic refer to:

• Oracle Calendar: Overview (http://www.cmu.edu/computing/doc/calendar.pdf)
• Oracle Calendar Desktop Client

(http://www.cmu.edu/computing/doc/calendar-using.pdf)
o Quick Reference (http://www.cmu.edu/computing/doc/QuickReference.pdf)

o Exporting Data (http://www.cmu.edu/computing/doc/calendarexport.pdf)

• Oracle Calendar Web Client (http://www.cmu.edu/computing/doc/calendarweb.pdf)
• Oracle Calendar Resources

(http://www.cmu.edu/computing/doc/calendarresource.pdf)
• Working as a Designate

(http://www.cmu.edu/computing/doc/calendardesignate.pdf)
• Guidelines for Use

o Students (http://www.cmu.edu/computing/guideline/calendar-students.html)

o Faculty and Staff (http://www.cmu.edu/computing/guideline/calendar.html)

Oracle Calendar 10.1.2 Enhancements
Scheduling

• You now have the ability to schedule external attendees (see step 7
of the Creating a Meeting section of The Oracle Calendar Workspace
(http://www.cmu.edu/computing/doc/software/calendar/desktop/meeting.html) ) in
Agendas using their e-mail addresses. Previously, you could enter only attendees
with valid Andrew Calendar accounts. E-mail notifications will be sent to these
people, but obviously, they will not be able to respond through Calendar. The
external attendee's name will be flagged in the attendee list with a special icon.

• Along with the External Attendees feature, entry owners have the
ability to set the reply status for External Attendees (see the section
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Viewing/Responding to an Entry in The Oracle Calendar Toolbar
(http://www.cmu.edu/computing/doc/software/calendar/desktop/toolbar.html) ).

• You now have the ability to set your reply for an entry that you created as you are
creating it (including free/busy information). This is done via the Reply tab which is
now visible as you first create the meeting.

• A new print option to include the attendance status has been added. This option
is available by default on Windows machines; Mac users must update their
preference file.

Searching

• This version of Andrew Calendar client offers an automatic name completion option
when opening agendas and tasks, adding people to entries, or locating a person.
Simply enter at least 3 letters of the person's last name. The name(s) of possible
attendees who match those letter will be completed for you. Note: In order to
activate this feature, you will need to change your preference settings.

Offline Capabilities

• You can configure the Calendar program to prompt you to switch offline when the
calendar server is unreachable; the program will also prompt you to reconnect
when the connection is restored.

• You now have the ability to synchronize your offline password with your online
password.

Preferences

http://www.cmu.edu/computing/doc/software/calendar/desktop/toolbar.html
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• You can now configure Calendar to send e-mail reminders and notifications to an
alternate e-mail address.

• Through the preference file, you have the ability to enable or disable pop-up
reminders for all meetings when the application is launched. Note that this setting
will take precedent over reply options that you have set for individual meetings.

• You can change your preferences so that your tasks are NOT timed by default. If
you choose this option, the task you create will display over an infinite number of
days.

For information on configuring preferences, see Configuring
Preferences in the Oracle Calendar
(http://www.cmu.edu/computing/doc/software/calendar/desktop/agenda/
preferences.html) .

Things you Should Know

Windows

• The menu structure has changed. Previously, you would select Edit > New
Meeting (or Daily Note, Day Event or Task). With version 10.1.2, you select these
functions from the File menu. Also, you previously selected File > Agenda then
Open or Open as Designate or File > Group View. With version 10.1.2, these
functions are selected from the File menu, but in a different subgroup.

• Previously, the shortcut key used to open another person's agenda was Ctrl+A;
now it is Ctrl + O.

• You can now set "Access" and "Importance" on the main create meeting window.
Previously, it was on the Details tab.

• The Access and Importance levels and the Attachment feature were previously
located on the Details tab; the Access and Importance levels are on the main New
Meeting window.

• The Attachment feature now has its own tab.
• The new Reply tab offers the ability to set your reply for an entry that you created

as you are creating it (including free/busy information).

http://www.cmu.edu/computing/doc/software/calendar/desktop/agenda/preferences.html
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Mac

• The Access and Importance levels and the Attachment feature were previously
located on the Details tab; the Access and Importance levels are on the main New
Meeting window.

• The Attachment feature now has its own tab.
• The new Reply tab offers the ability to set your reply for an entry that you created

as you are creating it (including free/busy information).

Last Updated: 11/09/06
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Usage Tips
When used properly, Oracle Calendar can be an incredibly powerful communication tool
for individuals and groups of people. As with any powerful tool, however, there are any
number of simple and seemingly harmless activities that can have an adverse affect not
only on your effective use of the system, but on the usefulness to thousands of others.

This document outlines many of the common pitfalls that we have identified and will
help you to avoid them. There are also points that will help you to avoid having an
adverse affect on the usefulness of the system for others.

These are only examples - in general, you should always consider how your actions
may be perceived by others and use your best judgment.

Meetings: Inviting People and Responding to Invitations

• Don't schedule time with faculty members unless you have their permission
to do so
Students should refrain from scheduling professors, advisors, teaching assistants
or any other member of Carnegie Mellon faculty for any meeting or event unless
they have been given clear permission to do so. If you are unsure, e-mail the
faculty member first and ask for permission to schedule with them.

• Don't invite people you don't know
In most cases, inviting someone you don't know to a meeting or other function will
cause confusion and, in some cases, some amount of resentment. Call or send
e-mail to the person beforehand to ask permission to schedule a meeting or, at the
very least, let them know why you're inviting them (e.g., because someone they
know told you to).

• Don't invite large numbers of people
There are few people who should have occasion to invite large numbers of people
to meetings, events or notes. Users' inboxes would tend to fill up very quickly
if every university event were announced through Oracle Calendar. The Event
Calendar (https://my.cmu.edu/site/main/page.calendar)  has been created for this
purpose.

• Make sure people know what you're inviting them to
When you invite people to meetings or other functions, make sure that the title is
descriptive enough that they'll understand the true purpose of the event. If possible,
use the Details tab to provide information such as topics of discussion, what to
bring to the meeting, and so on.

• Respond to invitations in a timely manner
When you respond to an invitation, you not only extend the courtesy of letting the
initiator know if you'll be attending but you also let others know when you'll be
available for other activities. When you are invited to a meeting or other event, that
block of time is set aside as "unavailable" until you respond. Anyone who tries to
schedule something with you will encounter a conflict if they attempt to schedule
during that time. If you respond that you will not attend, that block of time becomes
available for someone else to schedule an event.

https://my.cmu.edu/site/main/page.calendar
https://my.cmu.edu/site/main/page.calendar
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Managing your Calendar

• Let others know when you're unavailable
In order for your calendar to accurately reflect your availability for meetings or other
functions, you should enter as many of your scheduled committments as possible.
You can easily enter your classes as recurring meetings. Ask your employer to
enter your work schedule as soon as they know it, or enter it yourself as soon
as you receive it. You should also enter team practices, your intramural sport
schedule, or other sporting events in which you participate. Oracle Calendar is an
effective tool in managing your organization's carnival schedule.
There are most likely times when you are not in class or at work, but want to show
a block of time as unavailable. For example, you may want to schedule some
uninterrupted study time. You can schedule this time on your calendar as a meeting
to which only you are invited. When another user attempts to schedule a meeting
with you, they will see a conflict if they try to schedule during this time.

• Don't use meetings in place of Day Events or Daily Notes.
If you are scheduling an event that is casual or optional for all or part of the
scheduled time, enter it as a Note or Day Event, not as a meeting. For example,
let's say you want people to know that they can drop by your room between 9:00
and 11:30 a.m. to pick up their copy of your group project report. If you schedule
a meeting with those people from 9:00 a.m.to 11:30 a.m., anyone else who wants
to schedule a meeting with these same people will encounter a conflict and will
be forced to select a different time. However, if you set up a note entitled "Pick up
Group Project Report in Mudge House room 222: 9:00 - 11:30 a.m." people will
receive the message and other events can be scheduled during that time.
You can also use Day Events or Daily Notes to mark important dates (e.g., last
day to withdraw from classes, registration dates, payment due dates, etc.) from the
academic calendar.

• Accept Day Events, Daily Notes & Holidays
Your inbox will be much less cluttered if you simply accept the Day Events, Daily
Notes and Holidays that people have sent to you.

Setting Access Rights to Your Agenda

You have a great deal of control over who can do what with your agenda. However,
you should make sure that you don't set your access rights to be so restrictive that it
becomes difficult or even impossible for others to schedule time with you.

The guidelines will help you to retain your right to privacy without making it impossible
for other users to schedule meetings or other activities with you.

• Allow others to view as much of your time information as possible.
Unless there is a very good reason not to, you
should allow anyone to view the times that you have
scheduled. Giving everyone access to view the times
of your meetings and other activities will help people
to schedule with you only when you are available.
For information on how to give others additional
access rights, see Set Access Rights

http://www.cmu.edu/computing/doc/software/calendar/desktop/agenda/access.html
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(http://www.cmu.edu/computing/doc/software/calendar/desktop/agenda/
access.html) .

• Make sure your "Designates" have the access they need.
If someone else will be acting as your designate and managing your schedule for
you, make sure that they have access to the information and functions that they
need to perform this task appropriately. At the very least, Designates should have
"Modify" privileges to "Normal" level items so that they can schedule meetings in
your behalf.

• Understand the difference between access for viewing and inviting.
You can allow people to invite you to meetings without allowing them to view
detailed information about your meetings.

• Allow people to send you mail
The Oracle Calendar software allows people who are
scheduling meetings or other events to send e-mail
to the invitees. By default, you will be configured to
receive these messages. You can turn this option off,
but keep in mind that if you do, people will not be able
to send you mail through Oracle Calendar to inform you
of changes, meeting agendas, and so on. For more
information, see Set Agenda Preferences
(http://www.cmu.edu/computing/doc/software/calendar/desktop/agenda/
preferences.html) .

• Set the appropriate access level for each activity you schedule.
When you schedule an activity in Oracle Calendar, you should set its access level.
For example, you might want to enter a doctor's appointment with a "Personal"
access level, but would probably schedule a class time with a "Normal" level.

• Make sure your "Designates" have the access they need.
If someone else will be acting as your designate and managing your schedule for
you, make sure that they have access to the information and functions that they
need to perform this task appropriately. At the very least, Designates should have
"Modify" privileges to "Normal" level items so that they can schedule meetings in
your behalf.

• Understand the difference between access for viewing and inviting.
You can allow people to invite you to meetings without allowing them to view
detailed information about your meetings.

Designates

Oracle Calendar allows some users, known as designates, to maintain schedules
for other users. When used properly, the Designate feature is a very powerful one.
However, if you are a designate, there are some things that you should keep in mind to
prevent problems for you and the people for whom you maintain schedules.

• Make sure that you have the appropriate access to peoples' agendas.
To properly administrate agendas for other people, you should make sure that
they, at the very least, give you "Modify" access rights to the "Normal" level items
in their agendas. This level of access will allow you to schedule, modify, and accept
meetings on their behalf, which is the main objective of a designate.

http://www.cmu.edu/computing/doc/software/calendar/desktop/agenda/access.html
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To make sure that you can reasonably maintain other peoples agendas, encourage
them to allow you to at least see the times for their personal and confidential items.
They don't need to allow you to see the subject or other details, just the times.

• Don't schedule meetings as if they're YOUR meetings.
This is perhaps the most important of all things to avoid as a designate. When you
schedule meetings for another person, you should open that person's agenda as
a designate, then schedule the meeting. This gives that person ownership of the
meeting instead of you. You will still be able to modify the meeting in the future, but
so will the person for whom you're scheduling the meeting.
If you schedule the meeting from your agenda, you will encounter the following
problems:

o You will be set to attend the meeting. Therefore, if someone tries to invite you
to a meeting, you will appear to be unavailable for that time, even if you really
aren't attending the meeting you scheduled.

o If you are out of the office sick or on vacation, or for whatever reason are not
available to modify the meeting, no one else will be able to change the meeting
- not even the person for whom you scheduled it.

o If at any time you are no longer the designate for a person, all meetings that
you have scheduled for that person under your own agenda will need to be
scheduled again. There is no easy way to transfer ownership of a meeting from
one person to another.

Resources

Oracle Calendar allows student organizations to maintain schedules for "resources"
such as conference rooms. When handled properly, Oracle Calendar can be a very
powerful tool for scheduling resources

• All resources must have at least one designate.
Computing Services will create resources upon request, but each resource must
have at least one "designate" (up to a maximum of five) who will manage the
schedule for that resource.

• Use Oracle Calendar for complete management of the resource.
We recommend that you use only Oracle Calendar to maintain a resource
schedule. For example, if you set up a conference room as a resource in Oracle
Calendar but also maintain a schedule for that room on paper, you will most likely
run into scheduling conflicts as people record a meeting in one place but not in the
other. If you set up a resource in Oracle Calendar, be prepared to eliminate the
paper schedule.
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